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How Business Analyst helps you make better business decisions
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Overview of the Business Analyst menu
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A short introduction to ArcGIS
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Site Map versus Thematic Map layers
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What to read next
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Exercise 1: Selecting a geographic area and performing site prospecting
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The Refresh button can be used any time you want to refresh the
drawing of your map. If you click the map while it is drawing, it will
stop the draw process.

Data View button
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Exercise 2: Where are my customers?
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Exercise 3: Where are my stores?
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Exercise 4: Assigning customers to stores
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Exercise 5: Determining trade areas around my stores
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Exercise 6: Determining market penetration
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Exercise 7: Where are my best customers? What are their characteristics?
Where are other areas with people like them?
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Site prospecting 3
• Site prospecting on the map using

the Site Prospecting tool

• Site prospecting using the Site
Prospecting tool context menu

• Site prospecting using the
Business Analyst menu

• Site prospecting using the Find
tool
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Site prospecting
on the map using
the Site
Prospecting tool

1. Open the study area in which
you want to perform site
prospecting.

2. Click the Site Prospecting
tool.

3. Click where you want to
perform site prospecting on
the map.

Using any of these options
will produce the Analysis
wizard, which will let you
choose simple rings, drive
time, or threshold rings. Each
of these analyses is
described in detail in
Chapter 8, ‘Store analysis
and prospecting’.

See Also
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�

�

Ch03.pmd 10/28/2003, 10:34 AM48



SITE PROSPECTING 49

1. Open the study area in which
you want to perform site
prospecting.

2. Click the Site Prospecting
tool.

3. Right-click anywhere on the
map.

The Site Prospecting tool
context menu appears.

4. To perform site prospecting
using an address, click Find
point by address.

Enter the address you wish
to use in the text box, then
press Enter. �

Site prospecting
using the Site
Prospecting tool
context menu
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The Site Prospecting tool context menu appears.
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5. To perform site prospecting
using the point feature that is
currently selected, click Use
selected point. This option is
only active if a point is
selected on the map.

The Analysis wizard appears.
Choose the type of analysis
you want to perform.

6. To perform site prospecting
using coordinates, click Input
coordinates.

7. Type the latitude/longitude
coordinates you wish to use
in the text box in decimal
degrees, then press Enter.

Using any of these options
will produce the Analysis
wizard, which will let you
choose simple rings, drive
time, or threshold rings. Each
of these analyses is
described in detail in
Chapter 8, ‘Store analysis
and prospecting’.

See Also
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1. Open the study area in which
you wish to perform site
prospecting.

2. Click the Business Analyst
menu and point to Site
Prospecting.

3. To perform site prospecting
using an address, click Find
point by address.

4. Type the address in the text
box and click OK.

5. To perform site prospecting
using coordinates, click Input
coordinates.

6. Type the latitude/longitude
coordinates you want to use
in the text boxes in decimal
degrees, then press Enter.

7. To perform site prospecting
using a point on the map,
click Select Point on the Map,
then click the point on the
map for which you want to
perform site prospecting.

8. To perform site prospecting
using a selected point
feature, click Use selected
point. A point must be
selected on the map for this
option to be active.

Using any of these options will
produce the Analysis wizard,
which will let you choose
simple rings, drive time, or
threshold rings. Each of these
analyses is described in detail
in Chapter 8, ‘Store analysis
and prospecting’.

See Also

�����������	���
�����
��
��
����
������
���������
����������
�������
��
�������
�
��������
��
��
���������������
�
������
��
������������ 

Site prospecting
using the
Business Analyst
menu
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The Analysis wizard appears.
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Site prospecting
using the Find
tool
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1. Open the study area in which
you wish to perform site
prospecting.

2. Click the ArcMap Find tool
on the Tools toolbar.

3. Enter an Address, ZIP code,
or ZIP + 4 to use as the
center point for site prospect-
ing, then click Find.

4. Right-click the found location
to show the Find context
menu. Click Site Prospect this
Address.

Using any of these options
will produce the Analysis
wizard, which will let you
choose simple rings, drive
time, or threshold rings. Each
of these analyses is
described in detail in
Chapter 8, ‘Store analysis
and prospecting’.
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folder on a different drive

• Virtual versus defined study areas

• Using ZIP Codes

• Choosing states, counties, DMAs,
or MSAs from a map

• Choosing states, counties, or
MSAs from a list

• Using the entire United States

• Drawing a shape on a map
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• Drawing a shape on a study area

• Selecting shapes

• Opening a study area

• Renaming a study area

• Deleting a study area
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Using map documents to manage your work
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Saving your work as a map document
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Creating another
My Output Data
folder on a
different drive
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1. Click the Business Analyst
menu and click Preferences.

2. In the Business Analyst
Preferences dialog box
under Output Folder for this
Map, browse to or type the
path where you want the My
Output Data stored. The
folder name can be changed
from My Output Data to any
name you choose.

3. Click Apply, then click OK.

A My Output Data folder is
created in the location you
chose.
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Virtual versus defined study areas
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Using ZIP Codes
 
�����'������	�( $�)��	�
��	�	������ �
� ����� ������	��

��� ����	�� 
�	� ���
�	��� ����� ��

�� 	
���� 
����
�	��
�� ��� ��	
�	

� ������
�	
��*��� ����
��	�� �

���� �	���&��'��
����#���


��	������#� ��� 
�#������
�( $
)��	��� ������#����
��� ��
��	
�	� 
� ������ 
�	
��
� ����	�( $
)��	��

+��	� ��� ��	�( $�)��	�� ���
�
��� ��� ������	� ��� ����� �����

�	
������	�
������
���,-.�

�	�
����� ���		����� 
�������&	��� ��
������	�
���( $�)��	�������

�	��
��� ���&	�� �	/�	��	�

1. Click the Business Analyst
menu and click Create Study
Area.

2. In the Create Study Area
wizard, click Define study
area by selecting, click By
ZIP, then click Next.

3. Type the ZIP Codes you want
to define your study area,
then click Next.

To include all ZIP Codes with
a certain number sequence,
use a wildcard (*) after two,
three, or four numbers. �

�

�
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58 USING ARCGIS BUSINESS ANALYST

4. Type a name for the study
area.

You must provide a unique
name but can use spaces or
special characters.

5. Click Finish.

A study area appears in
black with the area defined
by the ZIP Codes you
entered.

�

�

A study area appears.
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Choosing states,
counties, DMAs,
or MSAs from a
map
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1. Click the Business Analyst
menu and click Create Study
Area.

2. Click By State, By County, By
DMA, or By MSA; click from a
map; then click Next.

3. Click the Select Features
tool, then click the county,
MSA, or state you want to
select.

Selected features are
highlighted yellow.

4. Optionally, you can use the
Zoom In tool to see the area
you want more clearly. �

�
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5. Optionally, click the Show/
Hide Labels button to see
names of counties, MSAs, or
states.

6. Optionally, click and drag a
box around the areas to
select more than one county,
MSA, or state. Alternatively,
you can hold the Shift key
down and click them.

7. To deselect a feature, hold
the Shift key down and click
the selected feature with the
Select Features tool on the
map.

Features remain highlighted
until you make a different
selection or deselect them.

8. Optionally, click the To List
button to see the names of
the features you’ve chosen in
a list.

9. Add or remove features from
the list as desired by clicking
the arrow buttons. Click the
To Map button to look at your
study area again on the map,
or click Next to continue.

10. Type a name for your study
area.

You must provide a unique
name but can use spaces or
special characters.

11. Click Finish.

The study area you chose
appears.

Show/Hide Labels
button

Select Features
button

Pan tool

Zoom Out button

Zooms Selected
Features button

Zoom In button

Full Extent button

Buttons on the Create Study Area
dialog box from a map

��
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Choosing states,
counties, or
MSAs from a list
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1. Click the Business Analyst
menu and click Create Study
Area.

2. In the Create Study Area
dialog box, click By County,
By State, or By MSA.

3. Click from a list, then click
Next.

4. Click the state you would like
to define for your study area,
then click To Map. �

�
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5. Click the Zooms Selected
Features tool to zoom to the
area you’ve selected from the
list.

6. Use the Select Features tool
to make changes by selecting
or deselecting areas. After
you are finished, you can
either look at the list of
features in your study area
again or click Next to con-
tinue.

7. Type a name for your study
area.

You must provide a unique
name but can use spaces or
special characters.

8. Click Finish.

The study area you chose
appears.
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Using the entire
United States
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1. Click the Business Analyst
menu and click Create Study
Area.

2. Click Use whole USA, then
click Next.

3. Type a name for your study
area.

You must provide a unique
name but can use spaces or
special characters.

4. Click Finish.

A study area of the United
States appears. You can then
use the Zoom In tool to draw
a box around the continental
United States, if that’s your
area of interest, to zoom to it.
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Drawing a shape
on a map
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1. Click the Business Analyst
menu and click Create Study
Area.

2. Click By drawing your own
area, then click Next.

3. To create a rectangle on the
display, click the Rectangle
tool, then click and drag a
box over the area that you
want to include in your study
area.

To create a circle on the
display, click the Circle tool,
then click and drag a circle
over the desired area. The
crosshairs indicate the center
of the circle.

To create a polygon on the
display, click the Polygon
tool, then click once on each
vertex of the shape you want
to draw. Double-click to finish.

4. To more clearly see the
desired area before you
begin drawing, use the Zoom
In tool.

5. To see names of counties or
states, click the Show/Hide
Labels button.

6. If you make a mistake while
drawing your shape, draw
another. The first shape will
disappear.

7. When you are finished
creating a shape on the
display, click Next. �
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Rectangle tool

Polygon
tool

Circle
tool

Zoom In tool

Show/Hide Labels
button
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8. Type a name for your study
area.

You must provide a unique
name but can use spaces or
special characters.

9. Click Finish.

The study area you chose
appears.
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Clipping all your
data so it only
includes the
study area
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1. Right-click the data frame
(the top level of the table of
contents hierarchy) or your
map area and click Proper-
ties.

The Data Frame Properties
dialog box appears.

2. Click the Data Frame tab.

3. Check the Enable check box.

4. Optionally, click the Specify
Shape button to specify the
shape you want.

5. To outline the features, click
Outline of Features, click the
dropdown arrow and specify
the layer you want to use,
then click the dropdown
arrow and specify the
features you want to use.

6. To set a custom extent, click
Custom Extent and type the
information in the text boxes.

7. Click OK in the Data Frame
Clipping dialog box.

8. Click Apply in the Data Frame
Properties dialog box.

9. Optionally, you can change
the background color by
using the Frame tab, then
clicking the Background
dropdown arrow and select-
ing a color.

10. Click OK to finish the
process.

The data clipping process
may take several minutes.
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Drawing a shape
on a study area
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1. In ArcMap, open the study
area you want to use to
create a new study area.

2. On the Drawing toolbar, click
the Shape dropdown arrow
and click the shape you want
to draw.

To draw a rectangle, click
and drag a box over the area
that you want to include in
your study area.

To draw a circle, click and
drag a circle over the desired
area. The crosshairs indicate
the center of the circle.

To draw a polygon, click
once on each vertex of the
shape you want to draw and
double-click to finish.

3. If you need to adjust the size
of your shape, click the
Select Elements tool, then
click any of the graphic
handles and drag.

Make sure that the graphic
remains selected (the
graphic handles should be
visible).

4. Click the Business Analyst
menu and click Create Study
Area. �

�

�Select Elements
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5. Click Define study area by
selecting, click By currently
selected shapes, then click
Next.

The wizard displays a
summary of the selected
shapes.

6. Click Next.

7. Type a name for your study
area.

You must provide a unique
name but can use spaces or
special characters.

8. Click Finish.

The study area appears. �
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9. You can now remove the
shape by clicking its center to
select it (the graphic handles
should be visible) and
pressing Delete.

The new study area will now
be visible.
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Selecting shapes
from a study area
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1. Open the study area you
want to use to create a new
study area.

2. Click the Selection menu and
click Set Selectable Layers.

3. Click the Clear All button,
then scroll down to Block
Groups (ESRI BIS) and check
the check box.

4. Click Close.

5. In the table of contents, check
the Thematic Map layer on
and check the Site Map layer
off as well as any other layers
that may obscure your
selection of block group
shapes. �
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6. Click the Select Features tool
on the Tools toolbar and click
the block groups you want.

To select more than one
shape, hold down the Shift
key as you click.

To deselect a shape, hold
down the Shift key and click
the selected feature with the
Select Feature tool.

7. Leaving the features se-
lected, click the Business
Analyst menu and click
Create Study Area. �

Selected block groups
are highlighted in blue.

�
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8. Click Define study area by
selecting, click By currently
selected shapes, then click
Next.

The wizard panel gives a
summary of the shapes that
you’ve selected to define
your study area.

9. Click Next.

10. Type a name for your study
area.

You must provide a unique
name but can use spaces or
special characters.

11. Click Finish.

12. You need to deselect the
block group shapes by going
to the Selection menu and
clicking Clear Selected
Features. The new study
area will then be visible.

�




�

�

Ch04.pmd 10/28/2003, 10:03 AM72



CREATING A STUDY AREA 73

Opening a study
area
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1. Click the Business Analyst
menu and click Create Study
Area.

2. Click the Use a saved study
area definitions button, then
click the dropdown arrow to
select the study area you
want to open.

3. Click Finish.

The study area opens into
the application window and
is added to the map docu-
ment.
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Renaming or
modifying a study
area
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1. Click the Business Analyst
menu and click Create Study
Area.

2. Click the Manage saved
study area definitions button.

3. Click the study area you want
to edit, then click Rename or
Modify.

4. In the Edit Study Area Name
window, type the new name
of the study area, then click
OK.

The study area is renamed.

5. To modify the study area, use
any of the Create Study Area
tools to revise the study area,
either by using a list method
or the map selection tools.
This window can be resized
by clicking and dragging its
corner. Click OK when you’re
finished modifying the study
area.

6. After making your changes,
close the Manage Study
Areas dialog box, then click
Cancel in the Create Study
Area dialog box.
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Deleting a study
area
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1. Click the Business Analyst
menu and click Create Study
Area.

2. Click the Manage saved
study area definitions button.

3. Click the study area you want
to delete, then click Delete.

Optionally, to delete all study
areas, click Delete All.

4. Click Yes or Yes to All in the
Delete Study Area window.

The selected study areas are
permanently deleted from
Business Analyst.

5. Click Close to exit the
Manage Study Areas dialog
box.
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Removing a study area
from the visible legend
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Adding data to Business Analyst 5
• Adding data to your map

• Adding customers and stores as
tabular data to your study area

• Adding customers or stores from a
shapefile

• Analysis layer setup

• Adding business listings and
business data from the Internet

• Setting field visibility

• Opening a customer or store layer

• Opening an existing analysis in a
new map document

• Renaming or deleting a customer or
store layer

• Substituting your own terms for
“customers” and “stores”

• Setting preferences
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Adding customers or stores as tabular data to
your map
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Adding data to your map
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Adding data using the Add Data button on the
ArcMap toolbar
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1. In ArcMap, open the map to
which you want to add a
customer layer; for example,
start with Business
Analyst.mxd and save it to a
new map document with a
name of your choice.

2. Confirm the analysis extent is
set as you desire. Any layer
added to the map while an
extent is active will be
associated with that analysis
extent.

3. Click the Business Analyst
menu and click Customer
Setup.

4. Click Create a new customer
layer, then click Next.

5. Click Tabular data, then click
Next.

6. Click In a file on my com-
puter, then click Next.

7. Click the Browse button and
navigate to the file on your
computer that contains your
customer data.

8. Click the file that contains the
customer data you want to
use, then click Add. �

Adding
customers as
tabular data to
your study area
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9. Click Next.

10. In the Geocode table of
addresses dialog box, click
the dropdown arrows to
define your customers’
locations.

If you don’t have the infor-
mation for a specific field,
click the dropdown arrow for
that field and click <none>.

11. Click Next.

12. Click the first dropdown
arrow and click the field that
contains the name of each
customer. If you don’t have
one, click <none>.

13. If you have a customer ID
field, click Find the customer
ID field and click the
dropdown arrow to choose it.

14. If you don’t have a customer
ID field, click Create a
unique ID field for me.
Business Analyst automati-
cally names the field
‘BA_New_ID’, but you can
specify another name.

For Business Analyst to
analyze each of your
customers, each one must
be uniquely identified.

15. If you have a field identifying
the store associated with
each customer, select it
using the last dropdown
arrow. If not, click <none>
and Business Analyst will
create one for you. �

Tip

Analyzing customers
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16. Type the name of the
customer layer in the text
box. Optionally, you can type
a comment in the comments
text box.

17. Click Finish.

18. Your customer points appear
as a layer in your map. A
shapefile (map-ready)
version of your data is
created and stored in the My
Output Data\Cust Layers
folder.
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Adding stores as
tabular data to
your study area
���� ������	
�� �
��� ������ ���
���� ��� 
��� ������� ��� ����
������ 
��
� ��	
�� ���� �����
�������	�
�����
���	�� �
����������

��� ���� ������� ��� ����� �����

��
� 
�� �
���
�� �
�
�

1. In ArcMap, open the map to
which you want to add a
store layer (for example,
Business Analyst.mxd).

2. Click the Business Analyst
menu and click Store Setup.

3. Click Create a new store
layer, then click Next.

4. Click Tabular data, then click
Next.

5. Click In a file on my
computer, then click Next.

6. Click the Browse button to
navigate to the file that
contains your store data.

7. In the Add Table For Store
Layer Geocoding dialog box,
click the file that contains
your store data, then click
Add.

8. Click Next. �

�

�
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9. In the Geocode table of
addresses dialog box, click
the dropdown arrows to
define your store locations.

If you don’t have the informa-
tion for a specific field, click
the dropdown arrow for that
field and click <none>.

10. Click Next.

11. Click the first dropdown
arrow and click the field that
contains the name or store
number of each store. If you
don’t have one, click
<none>.

12. If you have a store ID field,
click Find the store ID field,
then click the dropdown
arrow to choose it.

13. If you don’t have a store ID
field, click Create a unique
ID field for me. Business
Analyst automatically names
the field ‘BA_New_ID’, but
you can specify another
name.

For Business Analyst to
analyze each of your stores,
each one must be uniquely
identified. �

Tip

Analyzing stores
����������	�
������������

����	
�����������
��������
�
������
�
���
���	����	�����
�
������������
���������������������������������


����
��������������	��
�
�
���
�����������
������
���	�
��������	
����

�

�

�

�

	

Ch05.pmd 10/28/2003, 10:06 AM83



84 USING ARCGIS BUSINESS ANALYST

14. Type the name of the store
layer in the text box. Option-
ally, you can type a comment
in the comments text box.

15. Click Finish.

Business Analyst geocodes
your data.

16. Your store points appear as
a layer in your map. A
shapefile (map-ready)
version of your data is
created and stored in the My
Output Data\StoreLayers
folder.

�
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Adding
customers or
stores from a
shapefile
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1. In ArcMap, open the map
document to which you want
to add customers.

2. Click the Business Analyst
menu and point to Set
Analysis Extent to verify your
active analysis extent. Any
layers added to the map will
be put in the group layer
associated with this analysis
extent and placed in its group
layer.

3. Click the Business Analyst
menu and click Customer
Setup.

4. Click Create a new customer
layer, then click Next.

5. Click Map-ready data, then
click Next.

6. Click the option that de-
scribes where your customer
data is located, then click
Next. �

Tip

Using the Store Setup
wizard for this task
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7. If your shapefile is on your
computer, click the Browse
button. The Add Customer
Layer dialog box appears.
Navigate to and double-click
your file, then click Next on
the Customer Setup wizard.
Skip to step 9.

8. If your shapefile has been
added as a layer to your
current study area, click the
dropdown arrow to choose
the layer, then click Next.

If the shapefile isn’t in the list,
click Back and click In a file
on my computer.

9. Click the dropdown arrow to
choose the field that contains
the name of each customer
or store. If you don’t have a
name field, click <none>.
Click Next to continue.

10. If you have a customer ID
field, click Find the customer
ID field, then click the
dropdown arrow to choose it.

11. If you don’t have a customer
ID field, click Create a
unique ID field for me.
Business Analyst automati-
cally names the field
‘BA_New_ID’, but you can
specify another name.

12. Click the dropdown arrow to
choose the field in the
customer layer that contains
a unique identifier for each
store. �
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You may not have a store ID
for each of your customers.
In this case, click <none>. To
do simple or complex
customer market analyses or
create desire lines, you’ll
need to assign each cus-
tomer a store ID. You can do
this after you finish the
wizard by using the Assign
Customers to Stores wizard
in the Business Analyst
menu.

Note that you will not
perform this step if you are
using the Store Setup
wizard.

13. Click Next.

14. Type a name and comments
for your customer layer.

You must provide a unique
name but can use spaces or
special characters.

15. Click Finish.

Your customer points appear
as a layer in your map.

�
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Analysis layer
setup
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1. Click the Business Analyst
menu and click Analysis
Layer Setup.

2. Click the dropdown arrow
and click the layer you want
to set up, then click Next.

3. Click the variable or vari-
ables with which you wish to
perform the analysis layer
setup and click the arrow
buttons to move them over.
All variables in the layer will
show up here for setup, even
though you may have
changed the field visibility
property of the layer. When
you perform an analysis, the
field visibility settings will be
used. Click Next to
continue. �
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4. Click the Aggregation
Method text box, click the
dropdown arrow, and click
the Aggregation method you
wish to use.

5. Click the Weight text box,
click the dropdown arrow,
and click the weight you wish
to use.

6. Click Finish.

Your analysis layer is set up.

Note that you should always
weight data on individuals
(per capita income, median
age, and so on) by popula-
tion and weight data on
households (average
household size, median
household income, and so
on) by households.
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Tip

Layer variables
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Adding business
listings
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1. Click the Business Analyst
menu and click Add Business
Listings.

2. Type a name for the new
layer of businesses in the text
box.

3. Define your business search
by clicking the Search
definition button to the right of
the desired search category.
Click the Location Search
definition button.

The Select Location dialog
box appears.

4. Use the Find boxes or
browse the list of states,
cities, or ZIP Codes.

5. Check the box that appears
next to one or more geogra-
phies, then click OK to
continue.

6. Click the Type of Business
Search definition button. �

Tip

Restricting the Business
Analyst search
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The Identify Business tool
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7. Enter a keyword or SIC code
to search for the desired
business category and check
the box next to those which
are desired. You also have
the option of browsing the
lists of SIC codes and
descriptions or using the SIC
tree to find your desired
business category.

8. Click OK to continue.

9. Click Finish to execute your
search, add the new layer to
the table of contents, and plot
the points on the map.
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Adding business
data from the
Internet
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1. Set the analysis extent to the
study area to which you want
to add Internet data.

2. Click the Business Analyst
menu and click Add Business
Data From Internet.

3. Type the URL of the server
with which you want to work
in the text box, then click
Next.

4. If you have a User name and
Password, type them in the
text boxes. Otherwise, leave
the text boxes empty and
click Next.

Business Analyst connects to
the server. �
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5. Click a feature service or
map service and click Next.

6. Check the check box of each
feature layer you want to
load. To select all the feature
layers, click the Select All
button. To clear your selec-
tion, click the Select None
button.

7. Click Finish.

The layers you selected are
added to your map.

�

�

Select All button Select None button

�

The layers you selected are added to your map.
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1. In the table of contents, right-
click the layer you want to
change the visible fields for
and click Properties.

2. Click the Fields Visibility tab
and use the arrow keys to
move fields you select to the
Visible fields or Invisible
fields column.

3. You have the option of saving
the Visible fields list. This is
used when you have several
analyses to perform that may
use different field listings. You
can easily switch between
the visible fields by selecting
one from the Saved list
dropdown menu.

4. If you prefer to make your
field selection from a tree
structure of available field
categories rather than from a
list, click the Tree Structure
icon. You can then browse
the categories to find your
desired fields.

5. Click Apply, then click OK to
activate your selection.

Setting field
visibility
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Opening a
customer or store
layer
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1. In ArcMap, open the study
area to which you want to
add an existing customer or
store layer.

2. Click the Business Analyst
menu and click Customer
Setup.

3. Click Open, rename an
existing customer layer, then
click Next.

4. Click the layer you want to
open.

5. Optionally, click the Layer
Details button to see details
about your customer (or
store) layer. When you are
finished, click OK.

Details include:

• Name when initially
created

• Date created
• Store ID field
• Directory location
• Current name
• Comments
• Customer ID field

(customer layer only)
• Name field

6. Click Finish.

The layer is opened in your
study area.

Tip

Using the Store Setup
wizard for this task
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The Layer Details dialog box opens when
you click the Layer Details button.
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Opening an
existing analysis
in a new map
document
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1. In ArcMap, open the map
document to which you’d like
to add your analysis.

2. Click the Add Data button.

3. In the Add Data dialog box,
click the Look in dropdown
arrow and navigate to your
My Output Data folder.

4. Click the .lyr file that contains
the analysis you want to use,
then click Add.

The existing analysis is
added to your map.
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Renaming a
customer or store
layer or adding
comments
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1. Click the Business Analyst
menu and click Customer
Setup.

2. Click Open, rename an
existing customer layer, then
click Next.

3. Click the name of the layer
whose name or comments
you want to edit.

4. Click the Layer Details button
to see details about your
customer or layer. Click OK
when you’re finished.

Details:

• Name when initially
created

• Date created
• Store ID field
• Directory location
• Current name
• Comments
• Customer ID field

(customer layer only)
• Name field

5. Click the Edit Name/Com-
ments button to edit the layer
name or add comments
about it. �

Tip

Using the Store Setup
wizard for this task
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6. When you are finished
editing the name and adding
comments, click OK to
commit the changes.

7. If you want to open the layer
into the study area that’s
open, click Finish on the
Customer Setup wizard. If
not, click Cancel on the
Customer Setup wizard. Your
changes will still be
implemented.
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Deleting a
customer or store
layer
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1. Click the Business Analyst
menu and click Customer
Setup.

2. Click Delete a customer
layer, then click Next.

3. Check the box next to each
layer you wish to delete.

To select all layers for
deletion, click the Select All
button. To clear your selec-
tion, click the Select None
button.

4. Optionally, click a layer and
click the Layer Details button
to see details about the
selected layer. When you are
finished, click OK.

Details:

• Name when initially
created

• Date created
• Store ID field
• Directory location
• Current name
• Comments
• Customer ID field

(customer layer only)
• Name field

5. Click Finish.

The checked layers are
permanently deleted from
your map and from Business
Analyst.

Tip

Removing a layer from
your current map without
permanently deleting it
from Business Analyst
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Tip

Using the Store Setup
wizard for this task
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Select All button Select None button
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Substituting your
own terms for
“customers” and
“stores”
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1. Click the Business Analyst
menu and click Preferences.

2. On the General tab, type the
term you want to use to refer
to customers.

3. On the General tab, type the
term you want to use to refer
to stores.

4. Click Apply, then click OK.

Your preferences will be used
throughout the Business
Analyst wizards.
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The Preferences dialog box
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Setting
preferences for
working with data
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The General tab

1. In ArcMap, click the Business
Analyst menu and click
Preferences.

2. Click the General tab.

3. In addition to allowing you to
change the reference words
for customers and stores, the
General tab lets you define
the name and location for the
My Output Data folder. This
folder contains the custom-
ers, stores, analyses, and
study areas associated with
the map document.

4. The General tab also
contains a check box that lets
you turn an automatic Spatial
Reference update on and off.
This automatically adjusts the
map projection so that local
maps on the east and west
coasts of the United States
maintain the north orientation
up, even when you zoom in. If
the Spatial Reference update
check box is unchecked, the
projection that’s being used
at that time remains, regard-
less of how far you zoom in
or out. This will result in the
north direction moving left or
right of vertical on your map.

�
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102 USING ARCGIS BUSINESS ANALYST

1. In ArcMap, click the Business
Analyst menu and click
Preferences.

2. Click the Data tab.

3. The Data tab has several
purposes. If you have more
than one primary demo-
graphic dataset (for example,
ESRI BIS and AGS), you can
choose the current dataset
using the first dropdown
arrow.

4. In the Output Data Format
box, you can define whether
or not output data is stored in
shapefile or personal
geodatabase format.

5. The Data Component
Locations box defines where
each of the primary Business
Analyst data products can be
found. This permits you to
locate data in different places
on your hard drive or to refer
to your DVD drive to access
data.

Note that accessing large
amounts of data from a DVD
will decrease the perfor-
mance of Business Analyst.

6. The Geocoding services box
lets you select your desired
geocoder if you have more
than one.

The Data tab
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The Analysis tab
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1. In ArcMap, click the Business
Analyst menu and click
Preferences.

2. Click the Analysis tab.

3. The Analysis tab contains a
Fill Rings box that lets you
turn the color fill inside trade
areas on and off. By default,
these areas are filled with
transparent color. If you don’t
want any color, uncheck the
Fill Analysis rings box. If you
want color, check the box. You
can change the amount of
transparency or make the
colors opaque by right-
clicking the layer, clicking
Properties, and clicking the
Display tab. You can vary the
transparency from 0 percent
(opaque) to 100 percent
(invisible).

4. The Group Layer box lets you
choose whether or not
customer layers, store layers,
and analysis layers are
added to the map inside a
defined group layer. You can
also name the group layer in
this text box.

5. Optionally, you can check the
box to automatically set the
name of the group layer to be
that of the active analysis
extent at the time the layer
(customer, store, or analysis)
is added to the map docu-
ment.

�
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Customer analysis 6
• Assigning a store ID to your

customers by closest store, trade
area, or database assignments

• Creating simple and complex
market areas

• Creating market areas around your
customers

• Desire lines

• Calculating market penetration

• Potential sites

• Opening an analysis

• Renaming an analysis or adding
comments

• Modifying an analysis

• Permanently deleting an analysis

Businesses spend millions of dollars annually on focus groups, market
surveys, and other instruments to find out where people shop and why they
shop where they do.

Creating market areas

Though market areas can be defined by drawing a simple ring around a
store, the more precise the market area, the better the analysis. The better
the analysis, the better the plans to manage, improve, and expand business
within each market area.

With a precisely defined market area, you can target your advertising to
efficiently reach your customers exactly where they are. With a precisely
defined market area, you can locate a new store in an area with the same
demographics as your most successful store and get the most out of your
marketing dollars.

Only stores that fall within your study area will be analyzed if a study area
has been defined.
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106 USING ARCGIS BUSINESS ANALYST

Assigning a store
ID to your
customers by
closest store
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1. In ArcMap, click the Business
Analyst menu and click
Create Study Area.

2. Click Use a saved study area
definitions, then click the
dropdown arrow and click the
study area with which you
want to work.

3. Click the Business Analyst
menu and click Assign
Customers To Stores.

4. Click By closest store
location, then click Next. �

�

�
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5. Click the dropdown arrow to
choose the layer that
contains your stores.

6. Click the dropdown arrow to
choose the field in the store
data that uniquely identifies
each store, then click Next.

7. Click the dropdown arrow to
choose the layer that
contains your customers.

8. If you want to assign stores to
only selected customers, you
need to select a subset of
customers prior to using this
wizard, then return here and
check the check box.

9. Click the dropdown arrow to
choose the field that contains
each customer’s ID.

10. Click In a new field and type
a name for the field if you
want to save the store ID in a
new field.

11. Click the dropdown arrow to
choose the field you want
overwritten if you want to
overwrite an existing field in
your customer data.

12. Click Finish.

A store ID field is added to
the customer data, and the
customer points are dis-
played as different colors for
each store.
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Assigning a store
ID to your
customers by
trade area
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1. In ArcMap, click the Business
Analyst menu and click
Create Study Area.

2. Click Use a saved study area
definitions, then click the
dropdown arrow and click the
study area with which you
want to work.

3. Click the Business Analyst
menu and click Assign
Customers To Stores.

4. Click By trade area, then click
Next.��
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CUSTOMER ANALYSIS 109

5. Click the dropdown arrow to
choose the layer that
contains your trade areas.

6. Click the dropdown arrow to
choose the field that contains
the store ID for each trade
area, then click Next.

7. Click the dropdown arrow to
choose the layer that
contains your customers.

8. If you want to assign stores
only to selected customers,
click the check box.

9. Click the dropdown arrow to
choose the field that contains
each customer’s ID.

10. Click In a new field and type
a name for the field if you
want to save the store ID in a
new field.

11. Click the dropdown arrow
and click the field you want
overwritten if you want to
overwrite an existing field in
your customer data.

12. Click Finish.

A store ID field is added to
the customer data, and the
customer points are dis-
played as different colors for
each trade area. If your trade
area is on top of your
customer layer, you may
have to uncheck the trade
area to see the coloring.
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Assigning a store
ID to your
customers using
your database
assignments
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1. In ArcMap, click the Business
Analyst menu and click
Create Study Area.

2. Click Use a saved study area
definitions, then click the
dropdown arrow and click the
study area with which you
want to work.

3. Click the Business Analyst
menu and click Assign
Customers To Stores.

4. Click By using my assign-
ments. �
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5. Click the dropdown arrow to
choose the layer that
contains your customers.

6. Click the dropdown arrow to
choose the field in the
customer data that uniquely
identifies each store, then
click Finish.
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Simple market areas
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Creating simple market areas by number of
customers
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Creating simple and complex market areas
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Example: Simple customer market area by number of
customers
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Creating simple market areas by weighted value
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Example: Simple customer market area by weighted
value
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Defining the outer market areas
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Market Total households Average income

Primary 13,316 $48,961
Secondary 12,015 $65,783
Tertiary 47,207 $53,631
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Market Total households Average income

Primary 13,316 $48,961
Secondary 25,331 $56,940
Tertiary 72,538 $54,786

Complex market areas

5�	�������
��	��6��
���	����������
����������������������
�����
�����������
����������������������
������������������	�
�
��
��	��
������
����������	�������������������������
�����
����
�����

����������
��	��
������
�����	�
�����������	��������
�����������	���������������
����
��	��������
�������������������
������"�����	������������+�����
�	������
��	��6��
���	�����
����
��������	����
�������������
��������	�����	����������
�����
����������
����
�����
������������
����
���������
��������
��
��	�����
���
���������������
�"���������
��	��
������	�

�����
�����������	������������������
�	���������
�����

��
����������

�������������������������
������������������
���
����	�����������
��������
����������	�
��������������������
�	���
	����������
���
�
��"��������������"������������

<�
�������
�	����	����������
����	�����	����������
�����������	��
�

�������
������������
������������������������
�������	������
��
��	��
�����
�"��������������#
�����
�
���
������
��
$�

Ch06.pmd 10/28/2003, 10:09 AM114



CUSTOMER ANALYSIS 115

Creating complex market areas by number of
customers
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Example: Complex customer market area by number of
customers
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Creating complex market areas by weighted value

!
�"����
�	����	����������
���������������
��������	����������
"�����������"��������������
���������
���"��������������
�����

������	�������
�������
��
����������������
�
��7���������
�	�
��
��	���
����
��
���������������	�����	����������
�����
���	�
"���������
�
���
�

Example: Complex customer market area by weighted
value
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Creating market
areas around
your customers
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Selecting features by
clicking the map

1. On the ArcMap menu, click
Selection and click Set
Selectable Layers. Click
Clear All, then check the
desired layer from which you
want to select. Click Close to
continue.

2. Click the Select Features tool
and click the feature. To
select more than one feature,
hold down Shift when you
use the tool.

You can also use this tool to
drag a box over a group of
features you want to select.
Features that are selected
will be highlighted blue.

3. To deselect a feature that’s
already selected, hold down
Shift and click the feature
using the Select Features
tool.

4. Right-click the layer in the
table of contents and click
Open Attribute Table.

The attribute table appears.

�

Selected features are highlighted in blue.

�

The attribute table appears.

Ch06.pmd 10/28/2003, 10:09 AM117



118 USING ARCGIS BUSINESS ANALYST

Selecting features by
clicking the record in the
attribute table

1. Right-click the layer in the
table of contents that con-
tains the feature or features
you want to select, then click
Open Attribute Table.

2. In the attribute table, click
next to the record you want to
select.

3. To select all the records, click
the Options button and click
Select All.

4. To deselect all the records,
click the Options button and
click Clear Selection.

Tip

Selecting multiple records
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Creating market areas
around your customers

1. Open ArcMap and open the
study area that contains the
data you want to analyze.

2. Click the Business Analyst
menu and click Analysis.

3. Click Create a new analysis,
then click Next.

4. Click Customer Market
Analysis, then click Next. �

�

�

�
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5. Click either Simple or
Complex, then click Next.

6. Click the dropdown arrow to
choose the layer that
contains your customers.

7. Click the dropdown arrow to
choose the field that contains
each customer’s ID.

8. Click the dropdown arrow to
choose the field in the
customer data that contains
the store ID associated with
each customer.

9. Optionally, click Analyze
selected customers only to
create market areas using
only certain customers. A
selection must have been
previously made for this
option to be available.

10. Optionally, click Exclude
outlying customers to ignore
customer points a certain
distance past each store.
Type the cutoff distance in
the text box.

11. Click Next.

12. Click the dropdown arrow
and click the layer that
contains your stores.

13. Click the dropdown arrow
and click the field that
contains the store ID.

14. Click to select the number of
stores you want to create
customer market areas
around, then click Next. �

�
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15. Click the option that de-
scribes how you want the
percentages calculated.

If you click By a weighted
value, click the dropdown
arrow to choose the numeric
field that contains the value.

16. Click Next.

17. Click the number of trade
areas you want to create
around each store.

18. Type a percentage for each
trade area.

If you’re creating multiple
rings, the outer rings must be
a higher percentage than the
inner rings. For example,
50%, 70%, and 75% is
acceptable. 50%, 70%, and
60% is not.

These percentages repre-
sent either the number of
customers or a weighted
value—depending on what
you chose on the previous
panel.

19. Click the option that de-
scribes how you want to
define the outer rings, as
overlapping rings or donuts.

20. Click Next. �

�

�

�

�

�
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21. Type a name and comments
for your analysis. You must
provide a unique name but
can use spaces or special
characters.

22. Click Next.

23. Optionally, click the Report
check box to create a report
of your analysis.

24. If you’re creating a report,
click the dropdown arrows to
choose the templates.

25. Click Finish.

A layer containing customer
market areas is added to
your map. If you’re creating a
map or report, the report or
ArcGIS Layout windows
appear.

To print your report, click the
Print button on the report’s
application window. See the
Crystal Reports online Help
for more information.

To print your map layout,
make it active by clicking the
title bar. Click the File menu
and click Print.

�

�
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Desire lines
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Creating desire
lines
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1. In ArcMap, open the study
area that contains the data
you want to analyze.

2. Click the Business Analyst
menu and click Analysis.

3. Click Create a new analysis,
then click Next.

4. Click Customer Market
Analysis, then click Next.

5. Click Desire Lines, then click
Next. �

�

�

�
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6. Click the dropdown arrow to
choose the layer that con-
tains your customers.

7. Click the dropdown arrow to
choose the field in the
customer data that contains
each customer’s ID.

8. Click the dropdown list to
choose the field in the
customer data that contains
the store ID associated with
each customer.

9. Optionally, click Analyze
selected customers only to
draw desire lines using only
certain customers.

10. Optionally, click Exclude
outlying customers to ignore
customer points that are a
certain distance past each
store, then type the distance.

11. Click Next.

12. Click the dropdown list to
choose the layer that
contains your stores.

13. Click the dropdown list to
choose the field in the store
data that contains each
store’s ID.

14. Click the option that de-
scribes the number of stores
you want to create desire
lines around.

15. Click Next. �
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16. Click the option to specify
how you want the distance
stored.

17. Click the option to indicate
which field will store dis-
tance information. If you
want to create a new
distance field, click Create a
new distance field for me
and type the name of the
field in the text box.

18. Click Next.

19. Type a name and comments
for your analysis into the text
box. You must provide a
unique name but can use
spaces or special charac-
ters.

20. Click Finish.

A layer showing desire lines
is added to your map. If
you’re creating a map, the
ArcGIS Layout window
appears.

To print your map layout,
make it active by clicking the
title bar. Click the File menu
and click Print.

�
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Calculating
market
penetration
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1. In ArcMap, open the study
area that contains the data
you want to analyze.

2. Click the Business Analyst
menu and click Analysis.

3. Click Create a new analysis,
then click Next.

4. Click Customer Market
Analysis, then click Next. �

�
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5. Click Market Penetration,
then click Next.

6. Click the dropdown arrow to
choose the layer that con-
tains your customers.

7. Click the dropdown arrow to
choose the field in the
customer data that contains
each customer’s ID.

8. Optionally, click Analyze
selected customers only to
limit the analysis to certain
customers. The selection
must be in place before
initiating this wizard.

9. Click Next.

10. Click the dropdown arrow
and click the layer that
contains the areas for
calculating market penetra-
tion.

Optionally, click Use only
selected areas to calculate
market penetration using
certain areas.

11. Click the dropdown arrow
and click the field that
uniquely identifies each
area.

12. Click Next. �
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13. Click the option to specify
where the total market
counts for each area are.

If the total market counts for
each area are in the layer
attribute table, click that
option, then click the
dropdown arrow to choose
the field that uniquely
identifies each area.

If your market counts are in
Business Analyst data, click
that option, then click the
dropdown arrow to choose
the field that contains the
market counts.

14. Click Next.

15. Type a name and comments
for your analysis. You must
provide a unique name, but
you can use spaces or
special characters.

16. Click Next.

17. Optionally, check the Report
check box to create a report.
If you’re creating a report,
click the dropdown arrows to
choose the templates.

18. Click Finish. �

�

�




�

Ch06.pmd 10/28/2003, 10:09 AM129



130 USING ARCGIS BUSINESS ANALYST

A layer containing market
penetration is added to your
map. If you’re creating a map
or report, the report or
ArcGIS Layout windows
appear.

19. To print your report, click the
Print button on the report’s
application window. See the
Crystal Reports online Help
for more information.

20. To print your map layout,
make it active by clicking the
title bar. Click the File menu
and click Print.
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Calculating the centroid by number of customers
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Example: New store by number of customers

�����
��
���"��������������
�������������
�������������	���

����
����������"�	������������0�������
�������
��	����������

��"
������
���
�����������	�������	���������
��	���C����6
����	���"���6����������������"������
������

Potential sites

����������
���	�����������
����	���������
��������
�����
�"���

�	�������	��������
�������������
����	������������������	
�
��������5�
��	���������"������������������������������������

������	����������
����
��������
����������������"��������������
���������
���������������������"����������

Calculating the centroid by weighted value
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Example: New store by weighted value
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Locating a
potential site
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1. In ArcMap, open the study
area that contains the data
you want to analyze.

2. Click the Business Analyst
menu and click Analysis.

3. Click Create a new analysis
and click Next.

4. Click Customer Market
Analysis and click Next. �

�

�
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5. Click New Store and click
Next.

6. Click the dropdown arrow to
choose the layer that
contains your customers.

7. Click the dropdown arrow to
choose the field in the
customer data that contains
each customer’s ID.

8. Optionally, click Analyze
selected customers only if
you want to calculate the
centroid using only certain
customers.

9. Click Next.

10. Click the option that de-
scribes how you want the
percentages calculated.

If you chose By a weighted
value, click the dropdown
arrow to choose the field that
contains the numeric value.

11. Click Next. �
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12. Type a name and comments
for your analysis. You must
provide a unique name, but
can use spaces or special
characters.

13. Click Finish.

A layer showing the new
store centroid is added to
your map. If you’re creating a
map, the ArcGIS Layout
window appears.

To print your map layout,
make it active by clicking the
title bar. Click the File menu
and click Print.

�
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Opening an
analysis
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1. In ArcMap, open the study
area to which you want to
add an existing analysis.

2. Click the Business Analyst
menu and click Analysis.

3. Click Open, rename, or
modify an existing analysis,
then click Next.

4. Click the analysis that you
want to open.

5. Click View results.

6. Click Finish.

The analysis layer is added
to your study area. If you’re
creating a map, the ArcGIS
Layout window appears.

�
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Renaming an
analysis or
adding comments
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1. In ArcMap, open the map
document that contains the
analysis you wish to rename.

2. Click the Business Analyst
menu and click Analysis.

3. Click Open, rename, or
modify an existing analysis,
then click Next.

4. Click the analysis that you
want to rename, then click
the Edit Name/Comments
button. �

�
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5. Type changes into the text
boxes.

6. Click OK to commit the
changes.

7. If you don’t want to open the
analysis into your study area,
you can cancel the Analysis
wizard now. Your changes will
be implemented.

�
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Modifying an
analysis
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1. In ArcMap, open the map
document that contains the
analysis you wish to modify.

2. Click the Business Analyst
menu and click Analysis.

3. Click Open, rename, or
modify an existing analysis,
then click Next.

4. Click the analysis that you
want to modify.

5. Click Modify criteria, then
click Next.

You’ll be presented with the
panels used to create the
original analysis. Make any
desired changes. If you don’t
rename the analysis, the
existing one will be overwrit-
ten.

6. When you reach the last
panel, click the appropriate
check boxes if you want to
create a map or report of the
analysis.

7. If you’re creating a map or
report, click the dropdown
arrows to choose the tem-
plates.

8. Click Finish.

The modified analysis layer
is added to your study area. If
you’re creating a map or
report, the report and ArcGIS
Layout windows appear.
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Permanently
deleting an
analysis
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1. In ArcMap, open the map
document that contains the
analysis you wish to delete.

2. Click the Business Analyst
menu and click Analysis.

3. Click Delete an analysis,
then click Next.

4. Check the box next to each
analysis you want to delete.
To select all the analyses,
click the Select All button. To
clear all your selections, click
the Select None button.

5. Click Finish.

The selected analyses are
permanently deleted from
both your study area and
your My Output Data folder.

Tip

Deleting an analysis from
your map only
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Customer profiling and prospecting 7
• Customer profiling

• Creating a new customer profile

• Customer prospecting

• Customer prospecting with
demographic data

• Customer prospecting with
household data
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What are the demographic characteristics of my
customers?
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Creating a new
customer profile
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1. Click the Business Analyst
menu and click Analysis.

2. Click Create a new analysis,
then click Next.

3. Click Customer Prospecting,
then click Next. �
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4. Click the level of geography
you want to prospect.

5. Click State demographic
data, then click Next.

The Customer Prospecting
panel appears. Before the
wizard can find areas with
the kinds of customers you
want, you must specify the
characteristics you’re looking
for.

6. Click Profile.

The Customer Profile panel
appears.

7. Click the characteristics that
you want to look for in your
customers.

8. To select all characteristics,
click the Select All button. To
select all characteristics that
are profiled, click the Select
All Profiled button. To clear all
selected characteristics, click
the Select None button.

9. Click New. �
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10. Click the dropdown list to
choose the customer layer.

11. Optionally, click Profile
selected customers only if
you only want to include
certain customers in your
profile that were selected
before starting this wizard.

12. Click Profile.

A profile is generated with
averages for all the charac-
teristics you picked.

13. To save the demographic
characteristics and values
you’ve chosen to a customer
profile file (.cpf), click the File
button and click Save As.
Type a filename and click
OK.

14. You can select the same
characteristics the next time
you use Customer Profiling
by opening the customer
profile file. Click the File
button and click Open.

15. To print out the profile, click
Print.

16. To save the profile to a
dBASE table for further use
in other applications, click
Table.

17. To transfer the values in your
customer profile to the
Customer Prospecting
panel, click the characteris-
tics of your customer profile
that you want to transfer,
then click Populate. �
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146 USING ARCGIS BUSINESS ANALYST

18. Click how you want to
populate your customer
prospecting values. Only
characteristics that have
been profiled can be used.

To use floor values, click
Floor values only.

To use ceiling values, click
Ceiling values only.

To use both, click Floor and
ceiling values.

19. Type a percent variance to
create a range above or
below the profile value.

20. Check Clear unaffected
values to clear all existing
values from the Customer
Prospecting panel. If you
don’t check this box, any
values that you specified on
the panel will remain except
those that you are currently
populating. These values will
be overwritten.

21. Click Populate. The charac-
teristics you selected are
populated with the average
values for the level of
geography you chose.
Clicking on each category
will show the target charac-
teristics and values that will
be used in that category for
customer prospecting areas
that have similar characteris-
tics.
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Customer prospecting
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Customer
prospecting with
demographic
data
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1. In ArcMap, open the study
area you want to use for
Customer Prospecting.

2. Click the Business Analyst
menu and click Analysis.

3. Click Create a new analysis,
then click Next.

4. Click Customer Prospecting
and click Next. �

�

�

�
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5. Click the level of geography
you want to prospect.

6. Click the option to specify
which demographic data you
want to prospect.

7. Click Next.

8. Click the year of the demo-
graphic data that you want to
use.

9. Click Numbers or Percent-
ages.

If you’re targeting block
groups for people over 65
years of age, for example,
click Numbers to look for a
certain number of people
over 65, or click Percentages
to look for a certain percent-
age of people over 65 in
each block group.

10. Click the demographic
category of interest to
highlight it, then check the
target characteristic in which
you are interested. To clear
all selected categories, click
the Select none button.

11. Type Floor or Ceiling values
or both (numbers or percent-
ages) for each target value.
Do not enter commas or
dollar signs.

12. Select all the categories you
want to find in your custom-
ers, choosing target values
and floor and ceiling
values. �
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13. Click the option that de-
scribes whether you want to
match all or any of the
categories. This option
applies globally to all
categories and characteris-
tics. For example, if you’re
targeting tracts for people
with an average household
income over $35,000 and
over 50 percent home
owners, choosing Match all
characteristics would find
tracts that fit both these
requirements. Choosing
Match any characteristics
would find tracts with people
who had either an income
over $35,000 or had over
50 percent home owners,
not necessarily both.

14. To see a summary of all
selected categories, target
values, and floor and ceiling
values, click Show.

15. To save the demographic
categories and values
you’ve chosen to a demo-
graphic query file (.dmq),
click the File button. Type a
filename and click OK. You
can select the same catego-
ries and values the next time
you use the Customer
Prospecting wizard by
opening the demographic
query file. Click the File
button and click Open.

16. Click Next. �
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17. Type a name and comments
for your analysis. You must
provide a unique name but
can use spaces or special
characters.

18. Click Next.

19. Click the appropriate check
boxes to create a report of
your analysis.

20. If you’re creating a report,
click the dropdown arrows to
choose the templates.

21. If using a report template,
click Next to continue to the
next dialog box to name the
report before finishing. If
creating a new report, click
Finish to perform customer
prospecting and initiate the
Crystal Reports Report
wizard.

A layer showing the areas
that match your target values
and categories is added to
the study area. If you’re
creating a map and report,
the report and ArcView
Layout windows appear.

To print your report, click the
Print button on the report’s
application window.

To print your map layout,
make it active by clicking the
title bar. Click the File menu
and click Print.
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Customer
prospecting with
household data
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1. Open the study area you
want to use for Customer
Prospecting.

2. Click the Business Analyst
menu and click Analysis.

3. Click Create a new analysis
and click Next.

4. Click Customer Prospecting
and click Next. �

�

�

�
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5. Click the areas where you
want to target customers.

While the list shows many
levels of geography, only
map data is necessary and
the layers need not be in the
map of your study area.

6. Click Household data.

7. Click Next.

8. Enter your Hyphos360
Username and Password. If
you don’t have one, click the
Register at Hyphos360
button to register.

9. Click Next. �
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Registering at Hyphos360
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10. Type the minimum house-
hold target.

11. Click A numbers or A
percentages.

12. Click the option to specify
whether or not you want to
wait for results.

13. Click the desired category to
highlight it. Check the
appropriate characteristic in
the target values box on the
right.

14. To see a summary of all
selected categories and
target values, click Show.

15. To save the demographic
categories and values
you’ve chosen to a house-
hold query file (.hhq), click
File. Then click Save As,
click OK, navigate to where
you want to save the file,
type the filename, and click
Save.

You can select the same
categories and values the
next time you use the
Customer Prospecting
wizard by opening the
household query file. Click
the File button and click
Open.

16. Click Next. �
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When you click Show, the Demographic Query dialog box appears.
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Choosing whether or not
you want to wait for results
�����������
��
�������	�	����������
	
���	 ����	�5��
��	�	��������
6"��
�	������������
������
������

���
���	����	��
�"��	�����**)��������
����������������

$��������	�����
�
��������������������
	
���
����
�������
�	�����
	���

	
�	����	�
�������
���	���
�

$����������3���	�����������������	
�
�
����
�������
�	�����
	���
�	
�	
�	
��
���	��	�
������

7��������
��
����
����������������
���
���
�	
�	���������
������
����
����
��
�	���
������
���������
�	���	���#�

�	
��
&��	���	 ��	��������
	��
	���������������!�
������
�	��������
�������3���
����
���	���������

�������

�	����	�������	
�	�����

5��
�������������������������������	
�	
�������������������������	����-�������
8�	������"�����

�	������
������
	
�	�������
����
�����5��
���������
�	���������	�	�����	���**)��������

�
�
���������	����������������9���
������

�	���	�������	
�	�

/��
�5��
������������	���������
����
:����	
��
�����5��
��	���������
�
�	
�	���������
��������������
����
�	���

Tip

Using the Wait for results
option
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17. Type a name and comments
for your analysis. You must
provide a unique name but
can use spaces or special
characters. Click Next to
continue.

18. Click the Report check box
to create a report.

19. If you’re creating a report,
click the dropdown arrows to
choose the templates.

20. Click Finish.

A layer showing the areas
that match your target values
and categories is added to
the study area. If you’re
creating a report, the report
and ArcView Layout win-
dows appear.

To print your report, click the
Print button on the report’s
application window. See the
Crystal Reports online Help
for more information.

To print your map layout,
make it active by clicking the
title bar. Click the File menu,
then click Print.
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Store analysis and prospecting 8
• Simple ring analysis

• Data-driven ring analysis

• Equal competition areas

• Drive-time and drive-distance
analyses

• Creating market areas around your
stores based on drive time or
drive distance

• The Gravity Model

• Threshold ring analysis

• Store prospecting: simple ring,
drive time, and threshold ring
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Simple ring analysis

��������	�
������������	��	
������
���
������	�����������������
������
���	
	��������
����������	
������

��
	���	
����
���	�����
�

�������	

�		����	�
��
����
����
��������	���������������
���	���
��������	������������	
������
�����
	��	���������

����
�����		����
������
�

�����������	���
�	����

��
����
��
���	
	
����
�������������
���
����
����

�	��������
	�������������������
���
�������
����

�
��������

�	���������
���
�������������
�����

�
���������
�	���������������� ����
	������������������
�
��
��


�
���
��!�"�����
�����	�����	������
��

��������
��	!� ����
	
���������������	������

������
��

��
����
��	!����	���������
#��	�
�
	�������

��	���
�	���
�#�
������
����	
����
	����

�
������

��	���
�	�������
��������	��������
�������������
�
	���
$��
�
�������������������	�����
����

�	�������	���
�����
��
	�����
�

��

�����
�����������
�����
	��
����	

�
	�����

�������%���	����

����
���	�

�����������������������
�
�������

������
���	
	������		��
�����	��
�	�����

��	���
�	
����
��������%�������	���������������
	�
�	�������	���

�	���
���
������������	
�
�����

�	�����
��	����		������
	�

��������
�
	
����������
	�
�

�������������	����	
������

��	�������	����
���	
	�

�����&

' (��������
���������	����������
�����������	��
�����

�
���������
�	������
�����
��)*��
����

�	�����
������
���
����������������	�����������	��
������������

' (�������"�������
��	������
���������
�����������������	
�
��

���������
�����
��)*��
��	������������
�	����
�����


�	��	
��������
�	������	����������
�
�����
�
�	�

Ch08.pmd 10/28/2003, 10:13 AM158



STORE ANALYSIS AND PROSPECTING 159

Performing
simple ring
analysis
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1. In ArcMap, open the study
area that contains the data
you want to analyze.

2. Click the Business Analyst
menu and click Analysis.

3. Click Create a new analysis,
then click Next.

4. Click Store Market Analysis,
then click Next. �

�
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5. Click Simple Ring and click
Next.

6. Click the first dropdown
arrow and click the layer that
contains your stores.

7. Click the second dropdown
arrow and click the field that
contains the store ID.

8. Click the option that de-
scribes the number of stores
you want to create store
market areas around.

To use all stores, click the first
option.

To use only certain stores,
click Selected stores.

To use a single store, click
ByID or By name, then click
the dropdown arrow to
choose the ID or name of that
store.

9. Click Next.

10. Click the number of rings
you want around each store.

11. Type a radius for each ring.

For multiple rings, the outer
rings must be a higher
number than the inner rings.

12. Click the unit of distance you
want to use.

13. Click the option that de-
scribes how you want to
define the outer rings.

14. Click Next. �

�

�

�

�

�

�

�

�

	




Ch08.pmd 10/28/2003, 2:34 PM160



STORE ANALYSIS AND PROSPECTING 161

15. Type a name and comments
for your analysis. You must
provide a unique name, but
can use spaces or special
characters.

16. Click Next.

17. Optionally, check the Report
check box to create a report
of your analysis.

18. If you’re creating a report,
click the dropdown arrows to
choose the templates.

19. Click Finish. �

�
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A layer containing simple
rings is added to your map. If
you’re creating a map or
report, the report or ArcView
Layout windows appear.

To print your report, click the
Print button on the report’s
application window.

To print your map layout,
make it active by clicking the
title bar. Click the File menu
and click Print.
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Data-driven ring analysis
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Performing data-
driven ring
analysis
����������
� ��
��� ��
� ��
�������� ����
�� ����� ������
���
������
�������������� �
� ���
������ ������  ���� ������ ��� ���
�!���� ��� �� �����
��� �
�� ���
��
������������������ �
� ���������

 ���� ��� ��
������� ����� ��� ������
������� ������ ������ ���� ��	
����
����� ��� ����� �� ������ ��
��� ��

��������������� ������
����

�����
�������� ������	
������
�� "����

������������� ��� �����������
�� �

����	�����������

 �� �����	�
������� ������ ���
��
�� ��� ���#� ������� ���� ������ ����
�����	�
��� ���� �������� ���� �����
������"���������������
�������
������������
�� ������#� ��
�� ��� �

������$����$��"���������
%������
����� ������ ������
�� ��� ���#
������&����������������� ��
	�
�	�	#�	�$�	�	#��
��	��

��������

�����
� ���� ����� �������
�����������

"������
���������������%� �����
�������������
���
������'())#)))#
�����$�	
��#�������
��
�����
��
������
��	������
�#����
��������
�����'*))#)))��
����������������
������	������
�#�������������
'+,)#)))�������������+�,�	���
��
�#� �
�� ��� �
�� ���� ����� ���
�
���� �������� ����� 
�������

1. Open the study area that
contains the data you want to
analyze.

2. Click the Business Analyst
menu and click Analysis.

3. Click Create a new analysis
and click Next.

4. Click Store Market Analysis
and click Next. �

�

�

�

Ch08.pmd 10/28/2003, 10:13 AM164



STORE ANALYSIS AND PROSPECTING 165

5. Click Data-Driven Ring and
click Next.

6. Click the first dropdown
arrow and click the layer that
contains your stores.

7. Click the second dropdown
arrow and click the field that
contains the store ID.

8. Click the option that de-
scribes the number of stores
you want to create customer
market areas around.

To use all stores, click the first
option.

To use only certain stores,
click Selected stores.

To use a single store, click
ByID or By name, then click
the dropdown arrow to
choose the ID or name of that
store.

9. Click Next.

10. Click the dropdown arrow
and click the field you want
to determine the size of the
trade area.

11. Click Field statistics to see
minimum, maximum, and
mean values for the field you
chose.

12. Enter a value proportional to
a one-mile trade area.

13. The base trade area radius
can be one mile or one
kilometer. Click the desired
distance units, then click
Next. �
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14. Type a name and comments
for your analysis. You must
provide a unique name but
can use spaces or special
characters.

15. Click Next.

16. Click the appropriate check
boxes to create a report of
your analysis.

17. If you’re creating a report,
click the dropdown arrows to
choose the templates.

18. Click Finish.

A layer containing data-
driven rings is added to your
map. If you’re creating a
report, the report window
appears.

To print your report, click the
Print button on the report’s
application window.

To print your map layout,
make it active by clicking the
title bar. Click the File menu
and click Print.

�




A layer containing data-driven rings is added to your map.
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Equal competition
areas
�
������ ��
�� ��� �����������
	����������� ���������������
���	�
�
���� -����� ������

�������� 	�������.��  ���� ��
�
���	������ ����� ����	��� ����
��
��	��������� ������� ��� ���
�������������������������������
����
����
� �$������ �������� ������

���� ��	
���
�� ��
�����

/!���� ��	
������
� ������ ��

����� �� ������� �
������
��
�� ��
����
�������	����������������
���������� ���� ��� ��������� ��
����
	����������� �����������������
�
��������������	�����/���
�����	��� ����� ���������
�
������� ������� �� �
������� �����
�������
�� ���������
��	����
��
	����
��#� �
�� ���� �����	��� ��
��������� ��� ���� 
������� ������
 ���� ��������������	���������
�
�� ��
������� �
�������� ���� ���
�����

0�	�����������
����� �����������
����� �!���� ��	
������
� ������ ��
����
�����������	�������� ��
������ ��� ��������� ��� ����������
�������� ��� ���� �����	��#� �
�
������ ��� 
�� ��	
���
�� ������
�
���� �������
�� �
� ����� �!���
��	
������
� ����� ��
� ��
��������� ��� ������� �������� ��
��� ����
��
�� �
�� ������
���������/���� �
��	�
�� ����� ��

��� ����	��������� ������� ��� ���

��
��� ������ ������� ��� 
��
�� �

1. Open the study area that
contains the data you want to
analyze.

2. Click the Business Analyst
menu and click Analysis.

3. Click Create a new analysis
and click Next.

4. Click Store Market Analysis
and click Next. �
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168 USING ARCGIS BUSINESS ANALYST

5. Click Equal Competition,
then click Next.

6. Click the first dropdown
arrow and click the layer that
contains your stores.

7. Click the second dropdown
arrow and click the field that
contains the store ID.

8. Click the option that de-
scribes the number of stores
you want to create store
market areas around.

To use all stores, click the first
option.

To use only certain stores,
click Selected stores.

To use a single store, click
ByID or By name, then click
the dropdown arrow to
choose the ID or name of that
store.

9. Click Next.

10. Enter the buffer distance.

A good starting distance to
use is 5 or 10 miles. Large
regional centers may want to
use a larger number, such as
15 or 20 miles. However,
there is no rule of thumb for
a starting distance—it varies
by retailer.

11. Click the units of distance
you want to use.

12. Click Next. �
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13. Type a name and comments
for your analysis. You must
provide a unique name but
can use spaces or special
characters.

14. Click Next.

15. Optionally, check the Report
check box to create a report
of your analysis.

16. If you’re creating a report,
click the dropdown arrows to
choose the templates.

17. Click Finish.

A layer containing equal
competition areas is added
to your map. If you’re
creating a report, the report
window appears.

To print your report, click the
Print button on the report’s
application window.

To print your map layout,
make it active by clicking the
title bar. Click the File menu
and click Print.
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Drive-time and drive-distance analyses
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Creating market
areas around
your stores
based on drive
time or drive
distance
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1. Open the study area that
contains the data you want to
analyze.

2. Click the Business Analyst
menu and click Analysis.

3. Click Create a new analysis
and click Next.

4. Click Store Market Analysis
and click Next. �

�
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172 USING ARCGIS BUSINESS ANALYST

5. Click Drive Time and click
Next.

6. Click the first dropdown arrow
and click the layer that
contains your stores.

7. Click the second dropdown
arrow and click the field that
contains the store ID.

8. Click the option that describes
the number of stores you want
to create store market areas
around.

To use all stores, click the first
option.

To use only certain stores,
click Selected stores.

To use a single store, click
ByID or By name, then click
the dropdown arrow to choose
the ID or name of that store.

9. Click Next.

10. Check the first check box if
you want to create a new
layer (shapefile) that shows
all of the streets inside the
drive-time areas.

11. Check the second check box
if you want to join street
address ranges to the new
shapefile that shows tra-
versed streets.

12. Click the weight you want to
use. If you click Use distance,
click the units you want to use.

13. Click Next. �
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14. Click the number of drive-
time buffers you want to
create around each store.

15. Type a drive time in minutes
for each trade area.

If you’re creating multiple
rings, the outer rings must be
a higher value than the inner
rings.

16. Click the option that de-
scribes how you want the
buffers drawn.

17. Click the option that de-
scribes how you want to
define the trade areas.

18. Click Next.

19. Type a name and comments
for your analysis. You must
provide a unique name but
can use spaces or special
characters. Click Next to
continue.

20. Optionally, check the Report
check box to create a report
of your analysis.

21. If you’re creating a report,
click the dropdown arrows to
choose the templates.

22. Click Finish. �
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174 USING ARCGIS BUSINESS ANALYST

A layer containing drive-time
buffers (and streets, if
requested) is added to your
map.

To print your report, click the
Print button on the report’s
application window.

Drive-time
traversed
streets

Drive-time
polygon

Drive
distance
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The Gravity Model

(�	
�����	���
������
����	�����������
���������
��������
	����	�
���
�����
�
�����
��������������	�����
��
�
������
������
����	�
.���������
��	���������	�����������
�	�����
��������	������
��������
����

��	����	���������������
�

���(������
��
�		����������������
�������������
��
�
����
�	��
	��������������
�������
�
������
	���
��������������
��
�		�����
����
�����
��

������������
��
��
�
����������
�����
��	����������
�������������
��

�
��
(������
��
�		�
	������		����	��
��
���������������

�	��������
������	���������������
�����������
������
	��
��
������
	��	�����
�������������	��
�

�����(
���	
��������
�����
�
�����������
����
	
�
��
��������	��
�

������������	�����������
���������
������
�	
��	�����	����
	�

������������	��������
����������
�

�����
��
������������������������	�

��
�
���������
����

���
��
	�����	������

+�����
���
����������
	��
������������3���
����������
�������
��
5
������������������
����
�����		�������������������
���	��+�����

�	���������	���������,�
������������-�����	�
����������
	��
�������
	����������	���

+�����
�����	�������
	��
����

�	��������
������
��	�����
�������	�

��
	�	���
�
��
	�	�	���������
����	�������	��
�����
�����


�	


�������
������������
��������	�

Distance–Decay function
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The exponential function
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Performing
analysis using
the Gravity Model
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1. Open the study area you
want to use for analysis.

2. Click the Business Analyst
menu and click Analysis.

3. Click Create a new analysis,
then click Next.

4. Click Store Market Analysis,
then click Next. �
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178 USING ARCGIS BUSINESS ANALYST

5. Click Gravity Model and click
Next.

6. Click the first dropdown
arrow and click the layer that
contains the predicted sales.

7. Click the second dropdown
arrow and click the field that
contains the predicted sales.
Click Next to continue.

8. Click the first dropdown
arrow and click the layer that
contains your competition.

9. Click the second dropdown
arrow and click the field that
makes the competitor’s store
attractive. Click Next to
continue. � �
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10. Select the method for
identifying the new site
location, then click Next.

11. If you choose By clicking on
the map or By entering
address, you will then have
to enter the attractiveness
value for your new site. This
will be compared with that of
the competitor during the
analysis.

12. If you choose By selecting a
feature from either a point or
a polygon layer, use the
dropdown arrow to choose
the layer, feature, and field
containing the attractiveness
value.

13. Type the distance that the
Gravity Model will extend
from the new site location.

14. Type a distance–decay
exponent value.

15. Click the unit of distance you
want to use.

16. Click Next.

17. Type a name and comments
for your analysis. You must
provide a unique name but
you can use spaces or
special characters.

18. Click Finish.

The predicted sales for the
new site location appear.
Click OK to close this box
and view the Gravity Model
results.
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Threshold ring
analysis
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1. Open the study area you
want to use for analysis.

2. Click the Business Analyst
menu and click Analysis.

3. Click Create a new analysis,
then click Next.

4. Click Store Market Analysis,
then click Next. �
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5. Click Threshold Ring, then
click Next.

6. Click the first dropdown
arrow and click the layer that
contains your stores.

7. Click the second dropdown
arrow and click the field that
contains the store ID.

8. Click the option to select how
many stores you want to use.

9. Click Next.

10. Click the option to select
how many rings you want to
create for each store.

11. Click the dropdown arrow
and click the field you want
to use for threshold analysis.

12. In the text boxes, enter a
value for each ring.

13. Click the option to specify
how you want to define the
trade areas.

14. Click Next. �

�
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15. Type a name and comments
for your analysis. You must
provide a unique name but
you can use spaces or
special characters.

16. Click Next.

17. Optionally, check the Report
check box to create a report.
Click the first dropdown
arrow and click the layer you
want to summarize, then
click the second dropdown
arrow and click the report
template you want to use.

18. Click Finish.

A layer containing threshold
rings is added to your map. If
you’re creating a report, the
report window appears.

To print your report, click the
Print button on the report’s
application window.

To print your map layout,
make it active by clicking the
title bar. Click the File menu
and click Print.

�

�
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Store prospecting: simple ring, drive time, and threshold ring
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Evaluating a
potential store site
based on simple
rings around the
location
7�����
�
���
���� ���� �� ��������
������
���� ��	
��� ��
������
�
���� 
���
����� �����#� ���

������
�� ��	����
���� ��
����
���� ��	
�����
���� ����� �����

1. Open the study area that
contains the data you want to
analyze.

2. Click the Business Analyst
menu and click Analysis.

3. Click Create a new analysis
and click Next.

4. Click Store Prospecting and
click Next. �

�

�
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5. Click how you want to
identify your sites, then click
Next.

6. Follow the instructions on the
panel that appears. Depend-
ing on how you chose to
identify your sites, a different
panel will appear. Click Next
to continue.

7. Click Simple Ring, then click
Next. �

�

�

�

Ch08.pmd 10/28/2003, 10:13 AM185



186 USING ARCGIS BUSINESS ANALYST

8. Click the number of rings you
want to create around each
store.

9. Type a radius for each ring.

By definition, for multiple
rings, the outer rings must be
a higher number than the
inner rings.

10. Click the unit of distance you
want to use.

11. Click the option that de-
scribes how you want to
define the outer rings.

12. Click Next.

13. Type a name and comments
for your analysis. You must
provide a unique name but
can use spaces or special
characters.

14. Click Next.

15. Optionally, check the Report
check box to create a report
of your analysis.

16. If you’re creating a report,
click the dropdown arrows to
choose the templates.

17. Click Finish.

A layer containing simple
rings is added to your map.
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Evaluating a
potential store
site based on
drive time
8����1���
�����
�����#� ���
��
� ������� ��������	�� �����
����
�� 
�������� ������ �
�
������� ��	����
���� ��
����� ���
��	
�����
� ��� ����� �����

1. Open the study area that
contains the data you want to
analyze.

2. Click the Business Analyst
menu and click Analysis.

3. Click Create a new analysis
and click Next.

4. Click Store Prospecting and
click Next. �

�

�

�
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5. Click how you want to
identify your sites, then click
Next.

6. Follow the instructions on the
panel that appears. Depend-
ing on how you chose to
identify your sites, a different
panel will appear. Click Next
to continue.

7. Click Drive Time and click
Next. �

�

�

�
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8. Check the first check box if
you want to create a new
layer (shapefile) that shows
all of the streets inside the
drive-time areas.

9. Check the second check box
if you want to join street
address ranges to the new
shapefile that shows tra-
versed streets.

10. Click the weight you want to
use. If you click Use dis-
tance, click the units you
want to use. Click Next to
continue.

11. Click the number of drive-
time buffers you want to
create around each store.

12. Type a drive time in minutes
for each trade area.

If you’re creating multiple
rings, the outer rings must be
a higher value than the inner
rings.

13. Click the option that de-
scribes how you want the
buffers drawn.

14. Click the option that de-
scribes how you want to
define the trade areas.

15. Click Next. �

�
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16. Type a name and comments
for your analysis. You must
provide a unique name but
can use spaces or special
characters. Click Next to
continue.

17. Optionally, check the Report
check box to create a report
of your analysis.

18. If you’re creating a report,
click the dropdown arrows to
choose the templates.

19. Click Finish.

A layer containing drive-time
buffers (and streets, if
requested) is added to your
map. If you’re creating a
report, the report window
appears.

To print your report, click the
Print button on the report’s
application window.

To print your map layout,
make it active by clicking the
title bar. Click the File menu
and click Print.

�
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Evaluating a
potential store site
based on
threshold rings
around the
location
7�����
�
���
���� ���� �� ��������
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�� �� ���������� ��
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1. Open the study area that
contains the data you want to
analyze.

2. Click the Business Analyst
menu and click Analysis.

3. Click Create a new analysis
and click Next.

4. Click Store Prospecting and
click Next. �

�

�
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5. Click how you want to
identify your sites, then click
Next.

6. Follow the instructions on the
panel that appears. Depend-
ing on how you chose to
identify your sites, a different
panel will appear. Click Next
to continue.

7. Click Threshold Ring, then
click Next. �

�

�
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8. Click the number of rings you
want to create around each
store.

9. Click the dropdown arrow
and click the field you want to
use for threshold analysis.

10. In the text boxes, enter a
value for each ring.

11. Click the option that de-
scribes how you want to
define the trade areas.

12. Click Next.

13. Type a name and comments
for your analysis. You must
provide a unique name but
can use spaces or special
characters.

14. Click Next.

15. Optionally, check the Report
check box to create a report
of your analysis.

16. If you’re creating a report,
click the dropdown arrows to
choose the templates.

17. Click Finish.

A layer containing threshold
rings is added to your map.
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Using the Spatial
Overlay wizard
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1. Open the study area you
want to use for the spatial
overlay.

2. The Spatial Overlay wizard
will join fields from the Input
layer and fields from the
Overlay layer in the attribute
table of the new Spatial
Overlay layer. For this reason,
you may want to set the
visible fields in each layer
before combining them in the
new layer. This can be done
by right-clicking the layer in
the table of contents, clicking
Properties, and clicking the
Fields Visibility tab. This lets
you tailor the fields in the
new layer to those you
choose.

3. Click the Business Analyst
menu and click Spatial
Overlay.

4. Click the first dropdown
arrow and click the layer that
contains the data that will be
extracted (Input Layer).

5. Click the second dropdown
arrow and click the layer that
will inherit the new data
(Overlay Layer).

6. Click Next.

7. Enter a name for the resulting
Spatial Overlay layer and any
desired comments. Click
Finish to create the new
Spatial Overlay layer.
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Example of using Spatial
Overlay
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1. After creating the new spatial
overlay layer (for more
information on that see the
previous page), right-click
the layer and click Open
attribute table.

2. Right-click the field heading
Dominant ACORN Code and
click Sort Ascending.

3. Summarize the Dominant
ACORN codes by right-
clicking the field heading and
clicking Summarize. This
function will create a new
table with one record for
each unique ACORN code.

4. Click the first dropdown
arrow and click DOM_CODE.

5. Click Sales (+) in the second
information box and check
Sum. You can also summa-
rize the other fields if you
choose to.

6. Specify a location on your
computer to which to save
the new table and click OK.

7. Click Yes to add the resulting
table to your map.

Your table of contents will
shift to the Source tab to view
tabular data. The new
summarized table is added
to the bottom of the list.

8. Click the Close button to
close the Spatial Overlay
attribute table if you still have
it open. �
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9. Highlight the new summa-
rized table by clicking Sum
Output. Then, click the Tools
menu, click Graphs, and click
Create.

10. Click Column under Graph
type and the upper-left graph
under Graph subtype, then
click Next.

11. Click the dropdown arrow
and click the Sum_Output
table at the bottom of the list.

12. Check the box to use
selected records and check
the Sum_SALES field to
graph. Click to graph
Records in the table—rather
than Fields—and click Next.

13. Type the title “Total Sales by
Dominant ACORN Code”.

14. Check to Label X Axis With
DOM_CODE, Label Data
With Value, and Show
Legend.

15. Click Finish to create a
graph showing Total Sales
by Dominant ACORN Code
within your study area. �
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You can now see which
ACORN codes are account-
ing for most of your sales
and focus your marketing on
similar areas.

16. You can also create a report
of your spatial overlay
results by using the Reports
option on the Business
Analyst menu. To do this,
select the Spatial Overlay
layer as the boundary layer
and Census Tracts (ESRI
BIS) as the layer to summa-
rize.
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Find Similar
analysis
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Find Similar using a
master site picked on the
map or an address

1. Open the study area you
want to use for analysis.

2. Click the Business Analyst
menu and click Find Similar.

3. Click the first dropdown
arrow and click the layer that
contains the sites to be
scored.

4. Click either By selecting a
point on the map or By
entering address.

5. Click Next.��
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6. If you clicked By selecting a
point on the map, click the
map in the desired location
and skip to step 8.

7. If you clicked By entering
address, enter the Address,
City, and State, then click
Next.

8. Type a distance value to be
used to create the buffer
around each site.

9. Click either Miles or Kilome-
ters as the distance units.

10. Click the dropdown arrow
and click the level of
geography that will be used
to perform the analysis.

11. Click Next. �
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12. Click up to five variables to
use in scoring the scored
sites against the master site.
Click the variable names for
the corresponding Scored
Site Variables and Master
Site Variables.

13. Check the check box on the
left to select two or more
variables.

14. Enter a range percentage for
which the scored site value
can be above or below the
master site.

15. Click Next.

16. Type a name and comments
for your analysis. You must
provide a unique name, but
you can use spaces or
special characters.

17. Click Finish.

Each of the sites is scored
based on the number of
variables that matched the
values of the master site.
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Find Similar using a
master site from a layer

1. Open the study area you
want to use for analysis. This
example compares drive
times around the site.

2. Click the Business Analyst
menu and click Find Similar.

3. Click the first dropdown
arrow and click the layer that
contains the sites to be
scored.

4. Click By selecting a feature
from either a point or a
polygon layer.

5. Click Next.

6. Click the first dropdown
arrow and click the Master
Site layer.

7. Click the second dropdown
arrow and click the feature
that represents the master
site.��

�

�

�

�

�

�

Ch09.pmd 10/28/2003, 2:38 PM205



206 USING ARCGIS BUSINESS ANALYST

8. Since you’re comparing
polygons, no buffer distance
is needed. Click the
dropdown arrow and click the
level of geography that will
be used to perform the
analysis.

9. Click Next.

10. Click up to five variables to
use in scoring the scored
sites against the master site.
Click the variable names for
the corresponding Scored
Site Variables and Master
Site Variables.

11. Check the check box to
select two or more variables.

12. Enter a range percentage for
which the scored site value
can be above or below the
master site.

13. Click Next.

14. Type a name and comments
for your analysis. You must
provide a unique name, but
you can use spaces or
special characters.

15. Click Finish.

Each of the sites is scored
based on the number of
variables that matched the
values of the master site.

16. The finished analysis scores
all polygons based on the
number of variables that
matched the range values of
the master site.
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Finding a route 10
• The Find Route wizard

• Pointing and clicking on your map
to assign stops

• Using a point layer or table of
your stops

• Using addresses, ZIP Codes, or
latitude/longitude of your stops

• Using a point graphic or feature to
assign stops
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The Find Route wizard
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Add stop by address, ZIP, or
latitude/longitude

Add stop by layer,
table, or point
graphics or
features

Pick a stop

Move stops
up or down in
route order

Manage
stopped route

Open saved
stops

Save stop

Choose return stopCheck to have
route return to stop
upon completion

Do not add results
to the map

Add route or stops as
layers in table of
contents

Add route and
stops as map
graphic

Orders stops
to find most
efficient route

Use more or
less highways

Select either
quickest or
shortest route

Add graphic point or
callout for each stop
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The View Directions tab provides a listing of driving directions that can be printed, copied to the Clipboard, or used to zoom to
a particular route segment or the entire route.
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Pointing and
clicking on your
map to assign
stops
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1. Open the study area for
which you want to find a
route and zoom to the area of
interest.

2. Click the Business Analyst
menu and click Find Route.

3. Click the Add Stop tab.

4. Click the Pick Stop on Map
tool.

5. Click on the map where you
want to place a stop.

A stop is added to the map,
and the closest street
address appears in the list.

6. Optionally, add other stops to
the list by clicking the map.

7. To move a stop up or down in
the listed routing order, click
the stop in the list (the
corresponding stop on the
map is highlighted yellow),
then click the up or down
arrow buttons.

8. To remove a stop, click the
stop in the list and click the
Remove button.

9. If you want the route to end at
one of the stops previously
listed, check the Return To
box and select the desired
stop.

10. Click the Find button.

11. Click the View Directions tab
to see detailed directions for
your route that includes
distance in miles.
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Finding the best route
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Renaming stops
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Tip

Calculating the route using
a specific order of stops
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Using a point
layer or table of
your stops
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1. Open the study area for
which you want to find a
route.

2. Click the Business Analyst
menu and click Find Route.

3. Click the Add Stop tab, click
the Add Stops button, then
click Layer.

4. Click the dropdown arrow to
choose the layer of points
you want to use as stops.

If you want the route to use
every point in the layer, click
Use all stops. If you want to
use only selected stops, click
Use selected stops.

5. Click the Add stops button.

6. If your points are in a table,
click the Add stops button
and click Table.

7. Click the dropdown arrow to
choose the table of points
you want to use as stops.

8. Click Add stops to have the
geocoder locate the points
on the map. Follow the
geocoder steps to select the
appropriate fields. When the
geocoder is complete, click
Finish and close the log file
that’s created.

9. Optionally, add other stops to
the list using any method. �
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Finding the best route
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Renaming stops
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Table of points
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10. To move a stop up or down
in the listed routing order,
click the stop in the list (the
corresponding stop on the
map is highlighted yellow),
then click the up or down
arrow buttons.

If you want the route calcu-
lated using a specific order
of stops, make sure the list
shows that order.

11. To remove a stop, click the
stop in the list and click the
Remove button.

12. Click Find. The wizard
calculates the route for you
and draws it on the map.

13. Click the View Directions tab
to see detailed directions for
your route that includes
distance in miles.
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Using addresses,
ZIP Codes, or
latitude/longitude
of your stops
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1. Open the study area for
which you want to find a
route.

2. Click the Business Analyst
menu and click Find Route.

3. Click the Add Stop tab, then
click the New Stop button.

4. If using an address or ZIP
Code, input address and ZIP,
address/city/state, or ZIP. If
you only enter the ZIP Code,
the point will be located at
the ZIP Code center.

5. If using the latitude/longitude
(x,y) coordinates for the point,
click the XY Coordinate tab
and enter the latitude/
longitude in decimal de-
grees.

6. Click the Add Stops button.

7. Optionally, add other stops to
the list using any method.

8. To move a stop up or down in
the listed routing order, click
the stop in the list (the
corresponding stop on the
map is highlighted yellow),
then click the up or down
arrow buttons.

If you want the route calcu-
lated using a specific order of
stops, make sure the list
shows that order.

9. To remove a stop, click the
stop in the list and click the
Remove button. �
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Finding the best route
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Adding stops
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10. Click Find. The wizard
calculates the route for you
and draws it on the map.

11. Click the View Directions tab
to see detailed directions for
your route that includes
distance in miles.
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Using a point
graphic or feature
to assign stops
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Renaming stops
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Finding the best route
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1. Open the study area for
which you want to find a
route.

2. To select point graphics or
point features that are found
in a layer, click the Selection
menu and click Set Select-
able Layers to choose the
desired layer. You can then
select features or graphics on
the map using the Select
Features button on the Tools
toolbar.

3. Click the Business Analyst
menu and click Find Route.

4. Click the Add Stop tab, click
the Add Stop button, then
click Selected Point
Graphic(s) or Selected Point
Feature(s).

All selected graphics or
features will be added to the
route using this wizard.

5. Optionally, add other stops to
the list using any method.

6. To move a stop up or down in
the listed routing order, click
the stop in the list (the
corresponding stop on the
map is highlighted yellow),
then click the up or down
arrow buttons.

7. To remove a stop, click the
stop in the list and click the
Remove button.

8. Click Find. The wizard
calculates the route and
draws it on the map. �
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Selecting features and
graphics
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9. After the route is drawn, you
can deselect the selected
points by going to the
Selection menu and clicking
Clear Selected Features.

10. Click the View Directions tab
to see detailed directions for
your route that includes
distances in miles.
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Working with reports 11
• Creating a standard report of

Business Analyst data

• Creating a custom report of
Business Analyst data or your own
data
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Creating a
standard report
of Business
Analyst data
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1. In ArcMap, open the study
area you want to use to
create a report.

2. Click the Business Analyst
menu and click Reports.

3. Click the first dropdown
arrow and click the layer that
contains the boundaries.

4. Click Use only selected
boundaries if you want the
report to show demographics
only from certain areas in the
layer. Areas must be selected
before starting the Report
wizard.

5. Click the second dropdown
arrow and click the field that
provides a unique identifier
for each boundary.

6. Click Next. �
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7. Click the first dropdown
arrow to choose the layer
you want to summarize.

8. If you want the summarized
results added to the bound-
ary layer, check the Attach
summarized values to
analysis layer check box.

9. Click the second dropdown
arrow to choose the template
for your report.

A General Report contains
all categories (age, house-
hold, income, population,
and race).

10. If you want to use the Crystal
Reports designer to edit the
report form, check the box.

11. Click Next.

12. Type a name for your report.

13. Click Finish.

The options you chose
appear.

To print your report, click the
Print button on the Crystal
Reports application window.

See Also
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Creating a
custom report of
Business Analyst
data or your own
data
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1. Open the study area you
want to use to create a report.

2. Click the Business Analyst
menu and click Reports.

3. Click the first dropdown
arrow and click the layer that
contains the boundaries.

4. Click Use only selected
boundaries if you want the
report to show demographics
only from certain areas in the
layer. For this option, areas
must be selected before
starting the Report wizard.

5. Click the second dropdown
arrow and click the field that
provides a unique identifier
for each boundary.

6. Click Next. �
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7. Click the first dropdown
arrow and click the layer of
data you want to summarize.

8. Click Create new report for
me.

9. Click Finish to start the
Crystal Reports wizard used
to customize your report.

10. If you want your custom
report available in the future
as a template choice in
Business Analyst, save it to
the recommended template
directory.

This location is entered in
the Reports dialog box. �
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11. Because you will be using
the Crystal Reports wizard to
design your custom report, it
is necessary to select your
boundary layer. Click the
button to Create a report
using these layers or tables.

12. Check the box for the layer
that’s used as your boundary
layer.

The data for your report is
saved to a personal
geodatabase. You can
change the location and
name for this file if you
choose.

13. You can begin your custom
report with an existing report
template. If you have an
existing template you would
like to begin with, check the
box to browse to that
template.

14. Click Next.

15. If you’re overwriting the
report data personal
geodatabase, you will be
asked if you want to replace
it. In most cases, you should
click Yes. It won’t affect any
previously created reports to
overwrite this file.��
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16. Select the fields to use in the
custom report by clicking
them and using the arrow
keys to move them to the
column for Fields to Display.

17. Click Next through each of
the four dialog boxes—these
dialog boxes let you define
grouping categories to
organize fields, define what
fields are in each group
category, filter the data
values in each of the fields,
and set a report format
style—to reach a final dialog
box that lets you name your
report and define where to
save it. Note that if you click
Finish on any of the first four
dialog boxes, the wizard will
create the report and you
won’t be able to change the
report name.

18. When you reach the final
dialog box, type a name for
the report and enter the
location to which you wish to
save it.

19. You can preview the report,
then print it, edit it with
Crystal Report designer, or
view it later. Make your
choice and click Finish to
create your custom report.

Tip

Making a report available
as a custom template in
Business Analyst
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Working with maps 12
• Changing map appearance with

the table of contents

• Displaying points as charts

• Classification methods

• Displaying points as different
colors

• Displaying points as different
sizes

• Displaying lines as different colors

• Displaying lines as different
thicknesses

• Displaying charts in areas

• Displaying areas as different
colors

• Setting dot density in areas
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Changing map appearance with the table of contents
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Displaying points
as charts
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1. In ArcMap, open the study
area with the points you want
to display as charts.

2. Click the Business Analyst
menu and click Thematic
Mapping.

3. Click the dropdown arrow
and click the layer you want
to symbolize, then click Next.

4. Click Show each point as a
chart using this chart type,
click the dropdown arrow and
click Pie Chart, then click
Next.

5. If you want to use all features,
click All features. To use
Selected features, you will
first need to have the features
selected on the map or in the
layer’s attribute table. �
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228 USING ARCGIS BUSINESS ANALYST

6. Click the field with values
you want to see represented
in the charts.

7. Click the arrow button to add
the field to the list on the
right. You can add all the
fields by clicking the double
arrow button.

To remove a field, click the
arrow button that points to
the left.

8. Click the tree structure button
to view a tree structure when
the fields are grouped in
categories or click the list
button to view the available
fields in a box.

9. Click Next.

10. Click the dropdown arrow to
choose a color scheme.

Color schemes contain a
general color shading that
Business Analyst uses to
assign color variations to the
pie chart pieces. This
ensures contrast between
neighboring chart pieces.

11. Click Finish. The points will
be represented on your map
as pie charts.

Tip

Adjusting layer properties
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Classification methods
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Displaying points
as different
colors
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1. Open the study area with the
points you want to display as
different colors.

2. Click the Business Analyst
menu and click Thematic
Mapping.

3. Click the dropdown arrow to
choose the point layer, then
click Next.

4. Click Set the color of each
point based on this attribute,
then click Next.��
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5. Click All features to use all
features. Click Selected
features to use only the
features you have selected
on the map or in the layer’s
attribute table. Click Next to
continue.

6. Click the dropdown arrow
and click the color scheme
you want to use.

7. Click the dropdown arrow
and click the classification
scheme you’d like to use.

8. If you want to normalize the
result by dividing field values
by some other field in the
layer, click the dropdown
arrow and select the field. An
example could be to normal-
ize population count by area.

9. Optionally, click the Preview
button to see the results on
your map without changing it
permanently. To return to the
original legend, click Undo.

10. Click Finish.

The points in the chosen
layer are displayed as
different colors. �
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11. This wizard provides a
simple tool for thematic
mapping. More advanced
functionality is available by
right-clicking the layer,
clicking Properties, and
clicking the Symbology tab.
The wizard results are
shown here as well as other
thematic functionality.
Thematic results can be
easily turned off in the Layer
Properties dialog box. Under
Unique Values in the
Categories section on the
left side, pick a Value Field
and check the Symbol box.
Click Apply or OK, and the
symbol will replace any
thematic display of the
points.
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Displaying points
as different sizes
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1. Open the study area with the
points you want to display as
different sizes.

2. Click the Business Analyst
menu and click Thematic
Mapping.

3. Click the dropdown arrow to
choose the point layer, then
click Next.

4. Click Set the size of each
point based on this attribute,
then click Next.

5. Click All features to use all
features. Click Selected
features to use only the
features you have selected
on the map or in the layer’s
attribute table. Click Next to
continue. �
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6. Click the Color dropdown
arrow to choose a color for
the points.

7. Click the dropdown arrow to
choose a classification
scheme.

8. Optionally, click to choose
which normalization field you
want to use.

9. Click the Preview button to
see the results on your map
without changing it perma-
nently. To return to the
original legend, click Undo.

10. Click Finish.

The points in the chosen
layer are displayed as
different sizes.
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Displaying lines
as different
colors
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1. Open the study area with the
lines you want to display as
different colors.

2. Click the Business Analyst
menu and click Thematic
Mapping.

3. Click the dropdown arrow to
choose the line layer, then
click Next.

4. Click Set the color of each
line based on this attribute,
then click Next.

5. Click All features to use all
features. Click Selected
features to use only the
features you have selected
on the map or in the layer’s
attribute table. Click Next to
continue. �
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6. Click the dropdown arrow to
choose the color scheme you
want to determine the line
color.

7. Click the dropdown arrow to
choose a classification
scheme you want to use.

8. Optionally, click the
dropdown arrow and click
the normalization field you
want.

9. Click the Preview button to
see the results on your map
without changing it perma-
nently. To return to the
original legend click Undo.

10. Click Finish.

The lines in the chosen layer
are displayed as different
colors.

�

�




�

�

Ch12.pmd 10/28/2003, 10:17 AM236



WORKING WITH MAPS 237

Displaying lines
as different
thicknesses
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1. Open the study area with the
lines you want to display as
different thicknesses.

2. Click the Business Analyst
menu and click Thematic
Mapping.

3. Click the dropdown arrow to
choose the line layer, then
click Next.

4. Click Set the thickness of
each line based on this
attribute, then click Next.

5. Click All features to use all
features or Selected features
to use only selected features.
Click Next to continue. �
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6. Click the Color dropdown
arrow to choose a color for
the lines.

7. Click the dropdown arrow to
choose a classification
scheme.

8. Click the dropdown arrow
and click the normalization
field you want to use.

9. Click the Preview button to
see the results on your map
without changing it perma-
nently. To return to the
original legend, click Undo.

10. Click Finish.

The lines in the chosen layer
are displayed as different
thicknesses.
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Displaying charts
in areas
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1. Open the study area with the
areas you want to display
with charts.

2. Click the Business Analyst
menu and click Thematic
Mapping.

3. Click the dropdown arrow to
choose the layer with areas,
then click Next.

4. Click Show a chart in each
area using this chart type,
then click Next.

5. Click the dropdown arrow to
choose the type of chart.

6. Click All features if you want
to use all features or
Selected features if you only
want to use selected features.
Click Next to continue. �
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7. Click a field name with
values you want to see
represented in the charts.

8. Click the arrow to add the
field to the list on the right. To
add all the fields in the list,
click the double arrows.

To remove the fields, click the
field you want to remove and
click the left arrow.

9. Click Next.

10. Click the dropdown arrow to
choose a color scheme.

11. Click the Preview button to
see the results on your map
without changing it perma-
nently. To return to the
original legend, click Undo.

12. Click Finish.

Charts are displayed in the
areas.
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Displaying areas
as different
colors
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1. Open the study area with the
areas you want to display as
different colors.

2. Click the Business Analyst
menu and click Thematic
Mapping.

3. Click the dropdown arrow to
choose the layer with areas,
then click Next.

4. Click Set the color of each
area based on this attribute,
then click Next.

5. Click All features to use all
features, or click Selected
features to use selected
features. Click Next to
continue. �
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6. Click the Color dropdown
arrow to choose the area
color.

7. Click the dropdown arrow to
choose a classification
scheme you want to use for
the polygons.

8. Click the dropdown arrow
and click the normalization
field.

9. Click the Preview button to
see the results on your map
without changing it perma-
nently. To return to the
original legend, click Undo.

10. Click Finish.

The areas in the layer are
displayed as different colors.
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Setting dot
density in areas
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1. Open the study area with the
areas you want to show
using dot density.

2. Click the Business Analyst
menu and click Thematic
Mapping.

3. Click the dropdown arrow to
choose the layer with areas,
then click Next.

4. Click Set the dot density for
each area based on this
attribute.

5. Click the dropdown arrow to
choose the field for which
you want to determine the dot
density.

6. Type the value that you want
one dot to represent.

7. Click Next.

8. Click All features to use all
features or Selected features
to use only selected features.
Click Next to continue. �
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9. Click the Color dropdown
arrow to choose a color for
the dots.

10. Click the Preview button to
see the results on your map
without changing it perma-
nently. To return to the
original legend, click Undo.

11. Click Finish.

The areas in the layer are
displayed using dot density.
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1. Click Start, point to ArcGIS,
point to Business Analyst,
and click Study Area
Importer.

2. The importer will default to
the C:\ESRI_BIZ folder. Click
the Browse button and
navigate to the ESRI_BIZ
folder if it’s on a different
drive (or not located in the
default location). Click Next to
continue.

3. Click the study area that you
wish to import, then click
Next. �
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Saving the new .mxd
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4. Click the Browse button to
change the location of the
new .mxd file. You can also
import the store and cus-
tomer layers that are associ-
ated with the study area by
making sure the Import
stores and customers check
box is checked.

Note that you can choose to
continue importing other
study areas or open the
study area .mxd file in
ArcMap. If you choose to
import another study area,
the importer program will
return you to the first wizard
step; otherwise, the program
ends. If you wish to open the
imported study area, make
sure the Open imported
study area option is checked
in the next dialog box.

5. Check the check box if you
wish to open the current
imported study area.

6. You also have the option to
import another study area. If
you wish to import another
study area, click Yes and click
Next; otherwise, click No,
then click Finish.
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Report templates
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equal competition area
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Gravity Model
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My Output Data folder
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Spatial Overlay analysis
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